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Overview 

Byos provides two different workflows for Oligonucleotide Analysis – the Oligo workflow, which 
incorporates much of the same functionality as the Intact workflow, and the Digested Oligonucleotide 
workflow, which uses the same general UI platform as the Peptide workflows.  

Oligo Workflow 

The Oligo module allows users to evaluate a variety of nucleotide macromolecules such as: DNA, RNA 
and custom assemblies, including DNA/RNA combinations, phosphorothioate backbones, and user-
specified modifications. Common solvent- or LC column-related adducts are easily detected and 
highlighted. 

Features include: 

1. Support for all major mass spectrometry instruments and vendors 

2. Automatic or manual integration of chromatographic time windows 

3. Deconvolution of charge states to transform m/z spectra to neutral mass spectra 

4. Automatic mass peak picking and intensity calculations 

5. Sequence confirmation using MS2 fragmentation data 

6. Side-by-side comparison of multiple samples 

7. Reporting of summary data and figures 

Tour of Oligonucleotide Analysis Dashboard Views 

The Oligonucleotide Analysis user interface (UI), or dashboard, shown in the figure below has eight highly 
interactive plot and table views: 

 

Figure 1: Oligonucleotide Analysis Dashboard 

There are nine Oligonucleotide Analysis views: (1) Project table with input MS files, (2) Trace plot 
chromatogram with selected peak, (3) Trace Peaks table, (4) Masses table, (5) MS2 Data table, (6) MS2 
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and mass error plots, (7) MS1 spectrum (summed spectra), (8) Mass XIC plot, and (9) Deconvolved 
mass spectrum. Views can be rearranged, resized, docked, and undocked. Customized layouts can be 
saved and shared.  

1. The Project table lists the data files in use. The paired check boxes for MS files and result 
files can be used to turn on or off the records displayed in the other views. The colors of the 
files correspond to colors used in the other views. 

2. The Trace plot shows the total ion chromatogram (TIC), base peak intensity (BPI), 
ultraviolet (UV) trace, or electropherogram (icIEF). 

3. The Trace Peaks table summarizes the Trace plot chromatogram or electropherogram. 
Selecting a row in the table selects a peak in the Trace plot (View 2). Trace peaks can be 
merged, split, added, or deleted using the buttons at the top. Time limits can be adjusted by 
editing Start time, End time and/or Apex time fields or dragging the magenta bars shown 
in the Trace plot (View 2). 

4. The Masses table includes one row for each picked peak from Deconvolved Mass 
spectrum (View 9). The user can add, delete, or assign rows in the table. The name of a 
mass peak can be either its mass or an interpretation. 

5. The MS2 Data table shows the sequence information, along with the charge state, 
acquisition time and other details of the oligonucleotide. This table gets populated when 
selecting the precursor mass (from one or more rows) in the Masses table (View 4). Note 
that the MS2 Data table gets populated only when the selected row in the Masses table 
(View 4) has MS2 data. Each row of the MS2 Data table represents a MS2 scan of a single 
charge state of the selected mass in the Masses table (View 4). 

6. The MS2 and mass error plots show the MS2 spectrum of the oligonucleotide sequence 
selected in the MS2 Data table (View 5).  

7. MS1 shows the summed m/z plot for the chromatogram or electropherogram trace peak 
selected in the Trace plot (View 2) or Trace Peaks table (View 3). 

8. The Mass XIC plot allows user to assess elution profile of deconvolved species. 

9. The Deconvolved Mass spectrum is the primary output of the software. Neutral masses 
are plotted for the summed m/z plot (View 7) associated with the trace peak selected in the 
Trace plot (View 2) or Trace Peaks table (View 3). Hollow dots indicate picked peaks, the 
“candidate” masses that can be assigned for reporting. Once assigned, the dots become 
solid green and peaks become persistent. Outlined and colored dots interactively show 
selected peaks, connecting to the corresponding-colored dots in the m/z plot. 

Creating a Project  

Project Creation 

If the user already has a saved workflow, the oligonucleotide analysis can be started by clicking File > 
Launch Workflow, selecting the workflow and clicking Create Project (shown in below figure).  

The user has an option to edit an existing workflow by launching the workflow, making the edits to the 
workflow, and saving this as new workflow by clicking the Save Workflow (shown in below figure).  

The user can also create a new workflow by clicking the Oligo icon. This will result in a Project Creation 
window (shown in below figure).  
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Figure 2: Oligo workflow icon 

 

Figure 3: Oligonucleotide Analysis project creation window 

This multi-tab window allows the user [1] to analyze one or multiple mass spectrometer files, [2] to add 
corresponding set of oligonucleotide sequences and [3] to set-up the parameters required for the 
oligonucleotide analysis. Below are the steps for creating a sample workflow. 
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Sample Input Tab 

 

Figure 4: Sample Input tab 

MS sample files are added in the Sample Input tab. Oligonucleotide Analysis accepts a variety of 

reference sample files (Bruker: *.d, Thermo: *.raw, Waters: *.raw, SCIEX: *.wiff, Agilent: *.d). To 

enter a file, drag and drop an MS raw file into the project window. Alternatively, click Add sample, double-

click in the MS file column, click  and browse to the sample file. Click Open. 

The sample is named for the file name; to change the sample name, click the default name twice and enter 
a new sample name. Click Add sample at left to add a new row to the Samples table. Then add the 
desired files as above. To remove an unwanted sample file row, select the row and click Remove 
sample(s). 

Individual traces can be imported from sample file types supported in the MS file cell, as well as *.csv, 
*.txt files. If there are traces associated with a raw MS file, the traces table would be populated 
automatically to reflect these traces with TIC being selected as default. To import a trace from a file, drag 
the file into the Traces files column in the Samples table. Alternatively, double-click in the Samples table 

row under the Traces file column, click  and browse to the sample file. Click Open. The trace file is 
added to the sample name and the trace is added to the Traces table. 

Sequence Input Tab 

Next in the project creation window is the Sequence Input tab, which is further divided between two sub-
tabs: Sequences and Building blocks.  
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Sequences sub-tab 

The Sequences sub-tab is further divided into three sections: Chains, Sequence combinations, and a 
section for Biopolymer model. 

 

Figure 5: Sequence Input Tab - Sequences sub-tab 

To enter a nucleotide sequence, drag and drop a FASTA file into the Chains table. Alternatively, click 
Select from FASTA file, navigate to the file of interest, and click Open. Nucleotide sequences can also 
be typed or pasted in manually. To manually enter the sequence, click Add in the Chains section, and 
click in the Name and Sequence/average mass cells to enter text in those columns (See Building Blocks 
sub-tab section for Oligonucleotide naming convention). The chains can then be added as rows to the 
Sequence combinations table by selecting Mirror Chains table checkbox. The user can edit Sequence 
combinations table only after unselecting Mirror Chains table checkbox. 

NOTE: Sequence combinations table must be populated with the expected/desired masses to reflect the 
annotations in the Deconvolved Mass spectrum and other related plots/tables. 

The software automatically computes the average and monoisotopic mass for each selected FASTA entry, 
and these masses are then available for automatic peak assignment. Nucleotide sequences can be 
arbitrary if the user inputs the average or monoisotopic masses, overriding the computed masses. Average 
or monoisotopic masses give the software reference masses to assign mass peaks based on mass deltas 
(see Delta masses sub-tab section below). 
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Biopolymer model options include: 

 

Figure 6: Biopolymer models 

• Infer from sequence or biopolymer type is the default selection, which uses the 
standard model that Oligonucleotide Analysis uses to calculate mass. The standard 
model is defined by the Chemical Elements composition in the Building blocks sub-
tab of the Sequence-Input tab (see Building Blocks sub-tab section below). 

• Oligonucleotide uses the displayed averagine formula to calculate mass. 

• Phosphorothioate oligonucleotide uses the displayed averagine formula to calculate 
mass. 

• Custom opens a cell to the right of the selection to add a custom formula to calculate 
mass. 

Note that the formula values refer to atom counts (molar ratios), not mass ratios.  

Building Blocks sub-tab 

The Building blocks sub-tab contains information on naming convention for building oligonucleotide 
sequences. The user has an option to add new building blocks or edit the existing building blocks to change 
chemical formula. 

 

 

Figure 7: Sequence Input Tab - Building blocks sub-tab 
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Below is an example of naming convention for default residues shown in the Residues table (above 
figure). See Letter ‘Q’ in Residues table (above figure) as reference to build custom oligonucleotides. 

 

Figure 8: Example of oligonucleotide sequence naming convention 

The Byos Oligo workflow allows for full flexibility in defining types of building blocks (e.g., nucleobase, 
ribose, phosphate).   

Oligonucleotide molecules are specified by "building blocks", which are chemical formulas linked to letters 
or other characters. The 3' and 5’ termini are single-character building blocks with the default formula -OH 
and -H respectively. Within the sequence, building blocks come in groups of three characters, representing 
nucleobase, ribose, and phosphate linker.  

Any base can be combined with any sugar and any linker to form a nucleotide. Note that the order of 
building blocks within the sequence is important. The order is assumed to be:  

[5' terminal][RiboseBasePhosphate_1 RiboseBasePhosphate_2 ... 
RiboseBasePhosphate_n][3' terminal]' 

As an example (for notation, see the Letter and Type columns in Figure 7):  

<rA* mC* fU>  

specifies ribose adenine thiophospho for the first nucleotide, methylribose cytosine thiphospho for the 
second nucleotide, and fluororibose uracil for the third nucleotide. 5' terminates with an -H and 3’ 
terminates with an -OH. 

If a terminal is omitted, a default -OH terminal is assumed on 3' termini and -H on the 5’ termini.  

If a ribose symbol is omitted, a default C5O2H7 for ribose is assumed. 

If a phosphate symbol is omitted, a default -HPO3 is assumed. 

Note that these values have been updated as of release v5.8.  
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Mass Matching Tab 

The Mass Matching tab has two sub-tabs: Tolerances and Delta masses sub-tabs.  

Tolerances sub-tab 

The Tolerances sub-tab allows for setting the precursor mass tolerance (Tolerance under MS1 section), 
fragment mass tolerance (Tolerance under MS2 section) and the MS2 Fragmentation type. In the figure 
below, the MS1 Tolerance is set to 2 Daltons, the MS2 Tolerance is set to 50 ppm. 

 

Figure 9: Mass Matching Tab – Tolerances sub-tab 

Delta masses sub-tab  

The Delta masses sub-tab gives a table of likely mass differences between observed peaks and the 
reference mass input by the user or computed from an oligonucleotide sequence. The table includes delta 
masses of common oligonucleotide impurities. 

 

Figure 10: Mass Matching Tab – Delta masses sub-tab 

Import allows the user to import a *.csv table of custom delta masses.  
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Add row and Remove rows allow the user to enter individual delta masses.  

Add Combinations opens a dialog that allows the user to assign match tolerance modifications to a delta 
mass. 

Clips can now be anticipated from either 5' or 3' termini or both. This feature can be turned on during 
project creation within the Mass Matching tab by checking Consider Oligo impurities and setting the 
parameters in the Maximum clipped residues box. The Single end column limits the maximum number 
of residues clipped from either the 5' or 3' terminal. The Both ends column limits the number of clipped 
residues from either the 5' or 3' terminal when the opposite terminal is also clipped. The users can then 
go to the Masses table within the project and check the Oligo Candidate column to see the annotation of 
the internal clips. 

Spectrum Processing Tab 

The Spectrum Processing tab includes two sub-tabs, Basic and Advanced.  

Basic sub-tab 

The Basic sub-tab contains the primary settings used in computing deconvolved masses.  

 

Figure 11: Spectrum Processing Tab - Basic sub-tab 

Mass range and m/z range set ranges for neutral masses and m/z, respectively. Mass range defines the 
range of neutral masses displayed in the Deconvolved mass spectrum. m/z range defines the segment of 
the MS1 spectrum used to compute neutral masses.  

The Auto mass peak picking parameters control peak picking. Min difference between mass peaks 
(Da) prevents the peak picker from picking multiple points on top of a ragged or isotope-resolved mass 
peak. Max number of mass peaks sets a limit on the number of picked peaks.  

The Peak sharpening dropdown enables an optional “super-resolution step” for resolving larger masses 
beyond isotope resolution (if Enable sharpening from the drop-down menu is selected). 
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Advanced sub-tab 

The Advanced sub-tab mainly concerns resolution. These parameters are only needed if the aim is to 
produce isotopically resolved neutral mass spectra. 

 

Figure 12: Spectrum Processing Tab - Advanced sub-tab 

Charge vectors spacing assigns charge probabilities for each small interval of m/z points.  

Baseline radius controls the stiffness of the baseline. A baseline radius of 2 gives a flexible baseline that 
will cut into m/z peaks broader than 2 Thomsons.  

Spacing (m/z) controls the spacing of sample points in the m/z spectrum. The default value is 0.005. 

Smoothing sigma can be helpful for producing an appropriately smoothed neutral mass spectrum with 
less smoothing at lower mass and more smoothing at higher mass, if set at a larger value than Spacing 
(m/z). The default value is 0.001.  

Mass spacing controls the spacing of points in the neutral mass spectrum.  

Iteration max set to 10 will work for most purposes. If speed is an issue, this value can be set to 5. 

Charge range is best set to a wide range, in which case the charge range will be implied by the mass and 
m/z ranges. The default range of 1 – 30 covers most applications. 

NOTE: Spacing (m/z) and Mass spacing will only be effective when the advanced parameter 
SteppingMethod=constant is added to the advanced configuration during the project creation (See Oligo 
Analysis: Advanced Commands for additional details). 

Peak sharpening uses the Spread function width set in the Basic tab to deconvolve the data. The 
Advanced tab offers three infrequently used controls for peak sharpening. Blur skewness controls the 
asymmetry of the point spread function; the default value of 1.1 means that the right tail has sigma 
(standard deviation) 10% bigger than the left tail. 1.2 gives even more asymmetrical tailing; 1.0 gives a 
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symmetric point spread function. Range sets the length of the tails in standard deviations; a small value 
of 5 or 6 may work better in the case of Lorentzian point spread. The default is set to 8. Blur type has two 
options: Gaussian (skinny tails) and Lorentzian (fat tails). 

Sample-oligo input Tab 

Sample-oligo associations can be imported from *.csv files and from MS files. To create CSV files from 
other projects, use File > Export > Generate MS path template CSV. This capability is useful for making 
a single Oligo Analysis project with many samples. 

 

Figure 13: Sample-oligo input Tab 

Processing nodes Tab 

Processing nodes is where the user specifies the processing parameters to be applied during project 
creation and report generation. Each workflow is populated with default values, designed for the user to 
review once, and save for future projects. This empowers every member of a team, scientist within a lab, 
or colleagues across a project to complete the exact same analysis and generate identical reports 
regardless of Byos user-skill level, scientific expertise or experience, or location. Please note the next 
section will only have to be completed once for each analysis type and the workflow used for perpetuity. 

 

 

Figure 14: Processing nodes Tab 
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• General 

 

Figure 15: General parameters. 

o Samples - The “ * ” asterisk character applies all parameters to all samples dragged and 
dropped into the Samples tab. 

o Enable Lock-Mass Calibration can be set as Yes or No. 

o Lock Mass (m/z) sets the calibrant m/z value. Several are available using the drop-
down menu or the user can type in a numerical value. If empty, no calibration will be 
applied. 

o Mass assignments allows the user to turn on/off charge deconvolution and automatic 
mass assignment.  

 

• Mass Area and Relative Intensity Options 

  

Figure 16: Mass Area and Relative Intensity Options 

o Compute Areas of Mass Peaks 

o Mass Area Width compute peak area within a band around each mass, defined by the 
mass area width value. 

o Report Intensities Relative to Local Base Peak reports intensities based upon the two 
below parameters. 

o Window for Local Base Peak (%) sets tolerance for local base peak (e.g. mass within 
+/- 20%).  

o Minimum % of Local Base Peak filters out masses below a certain % of local base 
peak. 

o Generate zoomed-in segments: The user has 3 options: None, Using reference 
masses, Using observed masses (per highest local base peak).   

o Plot segment width can be set to automatically generate segments around 
reference/observed masses for deconvoluted mass spectrum and MS1 plots during 
project creation. 

• Advanced  
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Figure 17: Advanced commands 

Several advanced commands can be applied to Oligonucleotide Analysis processing by adding 
in the Advanced configuration text box. Please refer to the Oligo Analysis: Advanced 
Commands section of this user guide. For the Ionization Mode, the user has an option to select 
between Positive and Negative modes using the drop-down menu. 

• Report 

 

Figure 18: Report Configuration Path 

Each Byos default workflow includes a report template created by our Customer Success team 
that is optimized for the specific type of analysis. If the user prefers a customized report 
template, they can direct Byos to this file using the light blue “…” button (double-click on the 
row). They will be prompted to select a file. 

• UI Configurations 

 

Figure 19: UI Configurations – UI Column Filters and UI Layout.  

The user can import column filters as well as layout files. This is designed to standardize 
analyses across all users, labs, and sites. The user can direct Byos to the preferred file for each 
using the light blue “…” button (double-click on the row). The user will be prompted to select a 
file.  

• Time Settings 

 

Figure 20: Time Settings 

o Alignment max time sets the maximum alignment value between plots (for example, 
UV and TIC). This value will limit the allowed alignment time between the two signals. 
The default value is set to 1.00.  

• Label Scripts 
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This feature allows users to customize peak labels for Trace plot and Deconvolved Mass 
Spectrum. 

 

Figure 21: Label Scripts 

Scripts related to trace plot are in C:\Program Files\ProteinMetrics\PMI-
Suite\Base\labelscripts\traceplot folder, while the scripts related to deconvolved 

mass plot are in C:\Program Files\ProteinMetrics\PMI-
Suite\Base\labelscripts\dmsplot folder. To load a script during project creation, select 

Processing nodes, expand Label Scripts, click on … for Trace plot (or Deconvolved mass 
plot), then click Load to select a script, then click OK and Create Project. This will result in 
creation of the project with custom labels as specified in the script.  

The user has an option to load scripts after project creation as well. To customize peak labels 
after project creation, select Rendering options icon, click Edit Annotations, then click Load 
to select a script, then click Open and click OK to display new custom labels.  

Oligonucleotide Analysis  

Finally, save the workflow and start the oligonucleotide analysis by clicking Create Project. This will result 

in the generation of *.olms project file and a Oligo specific report being attached to the project.  

Below is the example project file generated that is discussed in detail in the Project Inspection section: 

 

Figure 22: Oligonucleotide project 

Below is the example report generated that is discussed in detail in the Reporting section: 
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Figure 23: Oligonucleotide report 

Project Inspection  

Project Table 

The Project Table contains information about the MS samples: 

 

Figure 24: Project View 

Check or uncheck Show trace or Show peaks to show or hide these features for sub-set of samples. To 
edit a MS sample, right-click the entry to edit under the Sample Name header, click Edit selected row(s), 
edit the name, and then click OK. 

Trace Plot 

The Trace plot shows the total ion chromatogram (TIC), base peak intensity (BPI), ultraviolet (UV) trace, 
or electropherogram (icIEF). 
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Figure 25: Trace Plot 

The menu bars at the top of the three plot views, Trace plot, MS1, and Deconvolved mass spectrum, 
share icons that that support generic operations on plots. 

• The  icon resets the plot to default zoom level. Shortcut = double left-click. 

• The  icon enables zooming in. After clicking, the cursor changes to . Drag across 
the range of the plot to display to zoom to that x-range. 

• By default, the plot’s y-range scales according to the maximum y-value within the x-
range, but the software also supports freeform zooming. 

• The  icon enables zooming out. Click anywhere in the plot to zoom out. 

• The  icon enables moving (panning) across the plot. Click the plot and drag up or 
down, right or left to view a part of the plot that is off-screen. 

• The  icon performs an undo of the last zoom step. Shortcut = Shift-left arrow key. 

• The  icon performs a redo of the last zoom step. Shortcut = Shift-right arrow key. 

• The  button scales the y-coordinates so that the tallest peak has intensity 1. 

• The  icon manages plot segments or zoom states. The number displayed in the icon 
shows how many plot segments are stored (named by the date and time of the save). To save 

the current zoom state as a plot segment, simply click the  icon. To switch to a previously 
stored plot segment, click the drop-down arrow and select the segment. 

• The  icon manages how plots are displayed (render options), as well as zoom 
modes.  

The Trace plot menu bar includes the following specialized control: 
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• The  icon shows the options for managing baseline anchors. The Trace plot baseline 
has no effect on the neutral mass spectrum, only the areas of the trace peaks. 

Trace Peaks Table 

The Trace Peaks table contains details about identified peaks, organized by sample: 

 

Figure 26: Trace Peaks 

To view specific peak data for a sample, click the > symbol to the right of that sample: 

 

Figure 27: Trace Peaks - Expanded sub-table 

The Trace Peaks table includes the following specialized buttons: 

• Add Peaks opens a dialog for the input of start and end times for a new peak. 

• Delete Peaks deletes the selected peak. 

• Merge Peaks merges a contiguous set of selected peaks into a single peak. Use left-
click and shift-click to select a set. 

• Split Peak splits a peak into two peaks. The time values for the two peaks can then be 
adjusted separately. 

• Filter options: The magnifying glass  opens a dialog that allows the user to adjust 
the trace peak filter by overall trace time or minimum peak area (percent of TIC) to determine 
which trace peaks will be processed. 

The Trace Peaks table includes the specialized right-click menu Edit selected row(s). This menu is 
available from certain numeric fields such as Start time, End time and Apex time, and for annotation fields, 
such as Mass Comment, Peak Comment and Visible. This allows the user to overwrite the computed 
values for those fields for the given sample, as well as mark or comment on samples peak records. 

Masses Table 

The Masses table reports the masses of the most intense peaks that are selected in the Trace Peaks 
table. 
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Figure 28: Masses Table 

The Masses table includes the following specialized buttons: 

• Assign Masses assigns selected rows, an alternative to checking the Assigned boxes. If there 
is no selected row, Assign Masses opens a dialog to define a new mass by name, neutral mass, 
start and end times, intensity, and comment. 

• Unassign Masses can be used to unassign selected rows. 

The Masses table includes the specialized right-click menu Edit selected row(s). This menu is available 
from certain numeric fields such as Mass Start, Mass End and Mass area, and along with other fields, 
such as Mass Comment and Name. This allows the user to overwrite the computed values for those fields 
for the given sample, as well as mark or comment on mass records. 

MS2 Data Table 

For a row highlighted in Masses table, the MS2 Data table provides information of the sequences, along 
with other details such as the mass, charge state, acquisition time, and score (a value which reflects the 
probability of randomly matching observed peaks to theoretical fragments). Each row of the MS2 Data 
table represents a single MS2 scan. 

 

Figure 29: MS2 Data Table 

Oligo scoring is based on a difference between the theoretical isotope pattern and the observed isotope 
pattern, and reflects the degree of correlation, with 100+ corresponding to nearly identical theoretical and 
observed patterns. 
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MS2 and Mass Error Plots 

The MS2 and mass error plots display plots of the MS2 spectra with the corresponding oligonucleotide 
fragments and a plot of their m/z mass errors: 

 

Figure 30: MS2 and mass error plots 

Depending on the selection of a scan in MS2 Data table, the MS2 spectra and the corresponding mass 
error plots are populated.  

• The  icon switches between the default spectrum view and the mass table view: 
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Figure 31: Fragment Masses table 

The reported fragment data that was confirmed in the analysis is displayed in red bold font. 

Unconfirmed fragment data is displayed in black font. In this view, the  icon switches the view 

back to MS2 plots. The  icon copies the content of this table to the clipboard. 

• The  icon switches between showing and hiding the fragment labels associated with oligo 
fragmentation. 
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MS1 Plot 

MS1 shows the summed m/z plot for the chromatogram or electropherogram peak selected in Trace 
peaks table. 

 

Figure 32: MS1 plot 

Mass XIC Plot 

The Mass XIC feature allows the user to quickly assess the elution profile of deconvolved species.  

 

Figure 33: Mass XIC Plot 

The Oligo module uses a sophisticated algorithm to improve signal to noise of XIC profile by optimally 
assembling information from multiple charge states of the same molecular compound. Mass XIC 
calculation, depending on LC peak width, can be computationally intensive and may need a runtime 
caching step. To provide XIC caching progress feedback, a progress bar Constructing Mass XICs tracks 
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the progress if the user selects non-cached data. Multiple peak selection in the Deconvolved Mass plot 
would result in showing Mass XICs for each of these peaks. 

If the user wishes to disable Mass XIC generation and remove it from the Project layout, the option “Enable 
Mass XIC” can be unchecked in the Window tab.  

 

Figure 34: Enable Mass XIC 

Mass XIC plot labeling can be customized within the Template Editor, which can be accessed by opening 
Plot Settings > Labels > Edit Annotations. From there, the user can enter an HTML script to customize 
labels as desired.  

 

Figure 35: Labeling Mass XIC plot in Template Editor 

Deconvolved Mass Spectrum 

Below is a Deconvolved mass spectrum from the m/z plots. The neutral mass peaks in a deconvolved 
mass spectrum represent oligo forms present in the sample. 

The Deconvolved Mass spectrum menu includes the single most important specialized control: the 
orange Compute button, which sets the parameters for the deconvolution. This Compute button 
functionality is like the Spectrum Processing Tab mentioned above. The user has the option to edit the 
parameters after project creation and re-run the analysis with new parameters and instantly get updated 
results. 
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Figure 36: Deconvolved Mass spectrum 

Reporting  

To create a report, select File > Export > Report or simply click the report icon  below the Help menu.  
The report allows a user to visualize the results of their analyses more simply in table or variable graph 
formats. There are multiple tabs that are populated within the Oligo reporting tab defined by the default 
report template. However, each tab can be customized to meet the individual research needs. 

Summary Tab 

The Summary Tab provides information on the samples processed along with high-level summary of 
deconvolved mass spectrum output. The Traffic Light view displays the status of Desired, Undesired and 
Unexpected counts. If the project fails to report any desired masses, this will result in ProjectStatus 
column being reported as “Fail”. 

 

Figure 37: Reporting – Summary Tab 
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Expected Mass - Relative Intensity % Tab 

This tab allows the user to tabulate the relative intensities of expected oligonucleotides, i.e., those masses 
that were combinations found in reference masses and delta masses table (see Delta masses sub-tab 
section). Each vertical column will add up to 100% and allow the user to better understand which oligo 
fragments predominate each sample (column name represent sample name). 

 

Figure 38: Relative Intensity of Expected Masses  

All Mass - Relative Intensity % Tab 

This tab allows the user to tabulate the relative intensities of all peaks identified in the Deconvolved Mass 
spectrum. 

 

Figure 39: Relative Intensities of All Masses 
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Bar chart of Intensities 

This interactive tab allows the user to visualize the relative intensity of selected oligo fragments from the 
project tab as a bar chart. Individual bars in the graph can be shown or hidden to gain a better 
understanding of their relative abundance by checking/unchecking the legend box at the bottom of the 
plot.  

 

Figure 40: Reporting – Intensities of few oligo candidates 

Expected and Observed Mass errors 

This tab provides information on the mass errors between expected and observed masses. 

 

Figure 41: Expected and Observed mass differences across all samples 

For custom report generation, please contact support@proteinmetrics.com. 

mailto:support@proteinmetrics.com
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Digested Oligonucleotides Workflow 

The Digested Oligonucleotides workflow is intended for use with samples that have enzymatically 
digested oligonucleotides like mRNA and MSMS acquisition with (high resolution) accurate mass 
instruments. It will match sequences and provide fragmentation displays in a viewer. 

 

Figure 42: Digested Oligonucleotides workflow 

This workflow includes the following actions:  

• Sequence Database Oligo Spectrum Matching (Byonic Oligo) 

• Confident isomer assignment 

• Detection and localization of modifications 

• Wildcard searching for modification discovery 

• XIC Plotting and MS1 Quantitation 

• Interactive data review tools and visualizations 

• Automated and customizable reporting 
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Digested Oligonucleotide Analysis Dashboard 

 

Figure 43: Digested Oligonucleotide project dashboard 

Creating a Project 

The Digested Oligonucleotides uses the same general UI platform as the Peptide workflows.  

The user has an option to edit an existing workflow by launching the workflow, making the edits to the 
workflow, and saving this as new workflow by clicking the Save Workflow (shown in below figure).  

The user can also create a new workflow by clicking the Oligo icon. This will result in a Project Creation 
window (shown in below figure).  
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Samples 

 

Figure 44: Sample input 

MS sample files are added in the Samples tab. Oligonucleotide Analysis accepts a variety of reference 

sample files (Bruker: *.d, Thermo: *.raw, Waters: *.raw, SCIEX: *.wiff, Agilent: *.d). To enter a 

file, drag and drop an MS raw file into the project window. Alternatively, click Add sample, double-click in 

the MS file column, click  and browse to the sample file. Click Open. Users can also drag and drop 
samples into the dialog to populate the samples row.  

The sample is named for the file name; to change the sample name, click the default name twice and enter 
a new sample name. Click Add sample at left to add a new row to the Samples table. Then add the 
desired files as above. To remove an unwanted sample file row, select the row and click Remove 
sample(s). 
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Figure 45: Add Samples 

Sequence tab 

In the Sequences tab, the user should add the oligo nucleobase sequence. Currently we support a 1-
character code. Byos Digested Oligo assumes a phosphodiester backbone, ribose or deoxyribose, and 
unmodified A, G, C, U, and T. Modifications can be used to change the default sugar, nucleobase, and 
phosphate linker. 
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Figure 46: Add sequence via FASTA 

Users can browse to add the sequence or drag and drop a FASTA file into the dialog to populate the 
Protein Sequence.  

Processing nodes 

 

 

Figure 46: Digested Oligonucleotide workflow parameters 

Under the Digestion tab, the user should define digestion to meet RNase digest rules. Digestion specificity 
allows for full/semi specific digestion search and a set of # of Missed Cleavages. A nonspecific search is 
unlikely to be useful for oligonucleotides.  
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Figure 47: Digestion tab 

Under the Modifications tab, the user should set Total Common and Rare Max as needed. Custom 
modifications can be updated by clicking on the ellipses in the Modifications row. 

 

Figure 48: Modifications tab 

By default, the Digested Oligo workflow assumes 5’ (NTerm) PO4H2 and 3’ (CTerm) OH termini for each 
digested oligo. NTerm and CTerm fixed mods are used to change the 5’ and 3’ termini to match the specific 
RNase used. Here, fixed NTerm and CTerm mods are used to set the termini for RNase T1 (5’ OH and 3’ 
PO4H2).  
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Figure 49: Select Modifications 

If no terminal modifications are applied, Byos Digested Oligonucleotides expects 5’ PO4H2 and 3’ OH. 

5’ PO4H2-ACCCAUUG-OH 3’ 

 

The Fixed Mods below adjust the Default 3’ and 5’ termini masses for an RNase T1 digested sample. 

5’ OH-ACCCAUUG-PO4H2 3’ 

Hydroxy 5'/ -79.966331 @ NTerm | fixed 

Phospho 3' / +79.966331 @ CTerm | fixed 

 

Adding % “comments out” the terminal modification. 

5’ OH-ACCCAUUG-OH 3’ 

Hydroxy 5'/ -79.966331 @ NTerm | fixed 

% Phospho 3' / +79.966331 @ CTerm | fixed 
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Figure 50: Modifications 

Set fixed or variable modifications as needed. Modifications can be applied generally or to localized spots 
with fixed mods on “unused” characters. 

Digested Oligonucleotide Analysis 

Project Inspection 

Project Table 

The Project table contains information about the MS samples and results files: 

 

Figure 51: Project table 
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To display or remove the MS sample and result combination, check or uncheck the box at left of either a 
sample or result record. To edit a MS sample or result alias name, right-click the entry to edit under the 
Alias Name header, click Edit selected row(s), edit the name, and then click OK. 

Oligonucleotide Coverage Table and Menu 

The Oligonucleotide Coverage table displays sequences and corresponding oligonucleotide coverage. 
The accompanying display maps the sequences of detected oligonucleotides to colored lines below each 
sequence representing colors assigned to different MS samples: 

 

Figure 52: Oligo coverage table 

The different colors within the colored bars indicate the presence of modifications at those positions. (The 
colors used are chosen for contrast and do not reflect the colors assigned to the MS sample files.) 

The Oligonucleotide Coverage table also includes the following specialized menu icon buttons: 

● The  icon opens the rendering options dialog: 
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Figure 53: Protein coverage rendering options 

● The  icon turns on and off the display of the tabular protein coverage data. 

The Oligonucleotide Coverage view has context menu items revealed by a right-click on the graphical 
portion of the display: 

 

Figure 54: Protein coverage right click menu 

● Rendering options also opens the Protein coverage rendering options dialog shown above. 

● Export coverage creates a *.png file of the graphical protein coverage display. 

● Export to FASTA creates a *.fasta file of the proteins found in the Protein Coverage view. The 
*.fasta file is then available to be imported into new projects. 
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Oligonucleotides Table and Menu 

The Oligonucleotides table contains detailed information about all identified oligos: 

 

Figure 55: Oligonucleotides table 

The Peptide table organizes records in the following hierarchy: Peptide > Sample > Charge state (if 
combined) > MS2 scan. Records in the Peptide table can be modified directly by the user for three fields: 
Validate, Comment, and Labels. In the Validate field, the user selects between “True-positive”, “False-
positive”, and “Uncertain”. Comments are input directly. Values for Labels are selected from a list. To 
create new labels to use in the Labels field, see Edit > Label Manager. 

Note: The MS1 correlation score compares the measured MS1 isotope distribution to the theoretical 
distribution calculated using cosine similarity. A score of 1 is a perfect match. 

In addition to the usual table menu buttons, the Peptides table contains the  icon button which opens 
the same Search Filter dialog that is opened by the Edit > Search Filter menu. The text filter entry box 
allows the records to be filtered based on the occurrence of the given text string searched across all fields. 

The Peptides table has context menu items applicable to specific peptides. The menu is revealed by a 
right-click on a peptide cell in the table: 

 

Figure 56: Peptides table right click menu 
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● Show/Edit alternatives displays a table of alternative MS2 identifications (with different sequences 
and/or modifications) for the selected peptide, along with their scores: 

 

Figure 57: Peptide alternatives table 

Select an alternative peptide and click Replace to replace the selected peptide in the Peptides table. 
Protein coverage, observed and calculated masses and m/z ratios all are updated. 

● Show Oligonucleotide summary opens a table with protein data for that oligo: 

  

Figure 58: Oligonucleotide summary 

The values in the Protein summary can be captured in a report using the template 
Blgc_PRM_wProteinDuplicates.rptc. 

● Show alternative glycan structures… allows the user to access alternative glycan structures 
rendered for glycopeptide modifications in generated reports featuring glycan cartoons. The 
table provides associated structures currently in the backend library. Users can also select Add 
new structure from IUPAC…to enter a new glycan structure to add to the library. See the PMI 
Chromatogram Analysis Manual for more information about building alternative glycan 
structures from IUPAC. 
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Figure 59: Glycan structure selection 

● Set XIC time interval allows the user to edit the XIC start and end times for that peptide and to 
set the time tolerance (time warp) to improve performance: 

 

Figure 60: Set time interval 

● Create new peptide from current makes a copy of that peptide. This allows XIC plots to be 
split according to separate integrations. The user edits the start and end times and the charge of 
the peptide before the copy is created: 
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Figure 61: Create new peptide from current 

● Edit proposed XIC splits opens a dialog to enter pairs of time ranges to split XIC plots for that 
peptide record into two or more chromatograms: 

  

Figure 62: Edit proposed XIC splits 

After a click on the OK button, the Peptides table record field XIC proposals is updated with the time 
range entries. The split must be applied to take effect. 

● Apply proposed XIC splits separates a record in the Peptides table into two or more records 
using the time ranges entered using the Edit proposed XIC splits function.  

● Add to XIC overlay adds the selected Peptides table record (subject to the right-click) or 
collection of records as an overlay to the XIC plots view mapped to the same time axis: 

 

Figure 63: Add to XIC overlay 

When this function is applied to a collection of records in the table, all of the records below it are added 
to the XIC plots view. 

● Remove from XIC overlay removes the overlay from the selected Peptides table record 
(subject to the right-click) from the XIC plots view. 
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● Clear overlays removes all sample overlays from the XIC plots view. 

Wildtype Peptides Table and Menu 

The Wildtype peptides table contains detailed information about naturally occurring or wildtype peptides 
associated with the peptide selected in the Peptides table: 

 

Figure 64: Wildtype peptides table 

The Wildtype peptides table has one context menu item specific to wildtype peptides. The menu is 
revealed by a right-click on a wildtype peptide cell in the table. Set primary wildtype marks that record 
as the primary wildtype peptide for the selected record in the Peptides table. 

XIC Plots and Menu 

The XIC plots view displays chromatograms for specific regions of the peptides and wildtype peptides 
associated with the record selected in the Peptides table:  

 

Figure 65: XIC plots 

In addition to the menu icon functions shared by all the plot views, there are some functions specific to 
XIC plots: 

● The  icon turns plot annotations on or off. In the XIC plots, annotations are displayed as 
circles at the base of the chromatograms. Dark red circles represent the position of currently 
displayed MS2 scans. Light red circles represent the position of other MS2 scans with the same 
identification. Light gray circles represent the position of MS2 scans with the same precursor 
mass as the selected peptide, but with different attribution. Hover over the circles and the 
associated sequence ID and value are displayed. Note that the cursor changes to a hand. Click 
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the circle and the corresponding Peptides table row is selected and the views are updated to 
display for that record.  

● The  icon is used to compute the XIC plot integration for a specified time range. A dialog 
opens to enter start and end times. 

● The  icon enables MS scan extraction. This displays isotope values derived from the XIC 
plot. A blue vertical line appears in the XIC plots view. As the line is dragged across the XIC 
trace, the Isotope plots view is updated to show the MS scan for that XIC time value. Two new 

icons appear on the Isotope plots menu bar in this mode: The  icon clears the extracted MS 

scan and restores the original isotope plots. The  icon saves the extracted MS scan to the 
project document. 

If Window > Enabled Stacked Plots is selected, XIC plots for multiple samples can be overlaid and their 
explicit XIC integration limits defined. 

 

Figure 66: Stack XIC plots 

With stacked plots enabled (via Window> Enable Stacked Plots), users can click and drag integration 
boundaries within XIC plots to simultaneously update start and end times for all samples and charges of 
a peptide. Subsequent changes will be reflected in the Peptides table.  
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Figure 67: Selection of multiple plots 

The option to edit multiple integration boundaries displayed in a set of stacked XICs at once is available 
with 'Shift+Click' and 'Ctrl+Click' actions. To move all start or end boundaries to the same retention time, 
hold down shift when clicking and dragging a boundary marker.  

Alternatively, holding ctrl when clicking and dragging will result in boundary markers moving by the same 
amount. 

If the user selects Combine Charge States under Edit>Search Filter>Peptide Grouping Method the 
application will display XIC traces for multiple charge states of the same molecule form in a single plot. 
This may provide additional evidence for the identity of the molecule. 

 

 

Figure 68: XIC traces for multiple charge states on one plot 
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Isotope Plots and Menu 

The Isotopes plots display the peptide isotope (m/z scan) for the selected Peptides table record:   

 

Figure 69: Isotope plots 

In addition to the menu icon functions shared by all the plot views, there are some functions specific to 
Isotope plots: 

● The  Show/hide annotations icon turns on and off the display of the molecular weight for the 
primary peptide beside a blue dot that identifies the peak with that calculated value. 

● The Sum MS1 icon is a local per-peptide summing option that sums MS1 scans for the 
selected peptide. If the XIC interval is adjusted by the user, the isotope plot will update 
accordingly. Note: Scan summing only works on projects created using v4.6 or later of Byos.  

● The  Theoretical isotope distribution icon renders the theoretical averagine distribution. The 
theoretical isotope distribution is calculated using the averagine model rather than the exact 
chemical composition. Theoretical isotope distribution is rendered using green sticks surrounded 
by green shaded transparent rectangular boxes. 
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MS2 and Mass Error Plots and Menu 

The MS2 and mass error plots display plots of the MS2 peptide fragments with the corresponding m/z 
mass error table: 

 

Figure 70: MS2 and Mass Error Plots 

The MS2 plots are identified by Scan ID. The plots are colored blue for N-terminus b ions and red for C-
terminus y ions. Other fragments, including c and z ions are colored green 

In addition to the menu icon functions shared by all the plot views, there are some functions specific to 
MS2 and mass error plots: 

● The  icon switches between the default plot view and the mass table view: 
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Figure 71: MS2 and mass error plots mass table view 

The reported fragment data that was confirmed in the analysis is displayed in red bold font. Unconfirmed 

fragment data is displayed in black font. In this view, the  icon switches the view back to MS2 

plots. The  icon copies the content of this table to the clipboard. 

● The  icon switches between showing and hiding the b and y ion labels. The icon is 
accompanied by a drop-down arrow that reveals three sub-menus: 

o Open annotation options opens a dialog that allows the user to set options for 
determining the assignment of the MS2 annotations: 

 

Figure 72: MS2 fragment annotation options 

The maximum number of peaks per 100 m/z and MS2 mass-accuracy tolerance options can use presets 
for Low accuracy, High accuracy, or Custom, in which the user sets these values. The dialog 
defaults to the Auto preset, in which the software determines the MS2 fragment annotation 
settings. 

o Remove fragment coverage cache clears the existing cache of detected fragments 
used for the protein fragment coverage rendering. 
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o Export fragment to CSV, exports the fragment sequence to a *.csv file. 

o The  icon turns on or off the fragment sequences displayed to the right of the plots. 

The MS2 and mass error plots view has two specific context menu items revealed by a right-click in the 
plot:  

● Apply peak filtering opens a dialog that allows the filtering of peaks by an entered signal-to-
noise ratio value. 

 

Figure 73: Peak filtering by signal to noise ratio 

● Combine MS2 spectra (MS2 and mass error plots only) sums the MS2 Plots for all the peptides for 
a selected row in the Peptides table. The title of the plot updates to show the counts of the peptide 
scans in the combined MS2 plot: 

 

Figure 74: MS2 plots after Combine MS2 spectra is applied 

Chromatogram XIC Plot and Menu 

The Chromatogram XIC plot displays the [1] Total Ion Current (TIC), [2] Extracted Ion Chromatogram 
(XIC) of a specific peptide, [3] Summed Extracted Ion Chromatograms (XIC summed) of one or multiple 
peptides eluting at a given time, and the [4] Total Ion Current difference (TIC difference). XIC Summed 
calculation features the core step of the chromatogram XIC plot. This feature helps the user visualize how 
much of the total signal (represented by the TIC) is accounted for by the collection of XICs. TIC difference 
is defined as TIC – XIC Summed. To open the Chromatogram XIC plot, choose Window > Show 
Chromatogram XIC Plot. 

The default view for the Chromatogram XIC plot shows the TIC curve and the XIC curve of all the peptides. 
The two peaks shown for the selected peptide (peaks between magenta lines) are the Total Ion Current 
(no-fill top peak) and Extracted Ion Chromatogram (red-filled bottom peak). 
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Figure 75: Default view of Chromatogram XIC plot 

In addition, XIC Summed and TIC Difference traces can also be overlayed. XIC summed is calculated 
by summing the XICs of isotopes of peptides, including different charge states. TIC difference can then 
be calculated using the formula, TIC – XIC summed. 

In addition to the menu icon functions shared by the other Peptide Analysis plot views, there are some 
functions specific to the Chromatogram XIC plot: 

● The  Settings icon opens the Plot Settings dialog. The dialog includes navigation to four 
areas [a] General, [b] Labels, [c] Summed mode, [d] Zoom options. 

o General – contains options to show and edit the plot title and limit the number of 
displayed peptides: 

 

Figure 76: General tab 

Edit plot title opens the Template Editor dialog: 
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Figure 77: Template Editor within General tab 

The Template Editor allows free entry of a plot title or the use of Short Codes. 

o Labels – contains options to show and edit annotations, limit the total number of labels 
and orient (rotate) labels: 

  

Figure 78: Labels tab 

Edit annotations also opens the Template Editor dialog. The default [PeptidesID] can be replaced with 
other annotations available in the “Short Codes” tab on the Template Editor menu (Note: a Chromatogram 
Analysis license is required to see the Labels section for Chromatogram XIC plots). 

 

Figure 79: Edit annotations 

Below are some of the options for the Short Code (1st column). 
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Figure 80: Short code options 

Selecting the [Sequence] Short Code would result in the below annotation of the peaks. 

 

Figure 81: Selecting [Sequence] Short Code to show peptide sequences as annotations 

o Summed mode – contains the option to select TIC difference calculation, along with 
XIC summed: 
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Figure 82: Summed mode tab 

o Zoom options – contains the standard zoom options, along with scrolling visibility: 

  

Figure 83: Zoom options tab 

● The filter  icon opens the Column Filters Editor dialog. The dialog enables filtering based on 
combinations of column values: 

 

Figure 84: Column Filters Editor for filtering data to plot 

● Center X zooms the segment and centers it in the frame: 
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Figure 85: Center X allows the user to center the plot on X-axis 

● Center Y, available when Center X is selected, zooms the segment and centers the height of the 
designated peak in the segment in the frame: 

 

Figure 86: Center Y allows to center the plot vertically  

● Summed button features the core step of the chromatogram XIC plot. This feature helps the 
user visualize how much of the total signal (represented by the TIC) is accounted for by the 
collection of XICs. In addition to the default TIC and XIC layers, additional layer XIC summed is 
generated when Summed icon is clicked. XIC Summed is the sum of all XICs of all the isotopes 
and at different charge states of the peptide. 



Oligo User Guide v5.12                   

 

54 

 

 

Figure 87: XIC Summed, TIC Difference and TIC curves 

Note that the calculation of the Summed XIC (and TIC difference, if checkbox is enabled in the  
Settings icon > Summed mode > TIC Difference shown in Figure 137) might take a while 
depending on the size of the raw MS files and the RAM of the desktop computer. 

The traces are plotted as layers (shown in the figure above) and user has an option to pick the set of 
traces to visualize. In the above figure, XIC layer rendering is hidden. This means, except the 
XIC layer, the rest of all of the layers can be seen. 

Reporting  

Oligo Summary Tab 

The Oligo Summary Tab provides information on the Project Creation options applied to the project as 
well as information concerning the samples processed including the Oligonucleotide coverage table. 
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Figure 88: Oligo Summary Tab 

Oligo Table 

The Oligo Table is a pivot table that provides XIC area summed isoX normalized per sample.  

 

Figure 89: Oligo table 

%Mod by ModName Across Samples 

The %Mod by ModName Across Samples tab is a pivot table that provides XIC ratio % of named 
modifications per sample.  
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Figure 90: %Mod by ModName across Samples 

%Mod (Multi Mods Per Oligo)  

 

Figure 91: %Mod (Multi Mods per Oligo) 

 

 

 

 

 



Oligo User Guide v5.12                   

 

57 

 

Oligo Analysis: Advanced Commands 

• Non-uniform stepping-based Deconvolution 

The user has an option to use nonuniform point spacing for both the m/z and m spectra using 
the advanced command below. 

[Intact] 

SteppingMethod=Linear 

MZResolution=35000 
SteppingMethod has 3 different settings:  Linear, SquareRoot or Constant. 

• Increased Resolution for Isotopically Resolved Data 

IsotopeEnvelopeFilter reduces the spurious peaks in the m spectrum. Peaks are considered 
spurious if they do not exhibit the expected “averagine” isotope envelope, either isotope resolved 
or almost isotope resolved. For most spectra, IsotopeEnvelopeFilter, especially used in 
conjunction with ChargeEnvelopeFilterPower2, will remove artifact peaks. 

[Intact] 

IsotopeEnvelopeFilter=true 

 

• Increased Sensitivity and Dynamic Range 

A more sensitive deconvoluted m spectra for low signal-to-noise oligo forms with many charge 
states can be obtained using ChargeEnvelopeFilterPower2 advanced command. The new 
algorithm can improve Limit of Detection (LoD) more than 10-fold.  

 

[Intact] 

ChargeEnvelopeFilterPower2=true 

 
For smaller masses (less than 20KDa) which is typical for Oligo workflow, additional parameter 
ChargeEnvelopeWeights can be used:  

[Intact] 

ChargeEnvelopeWeights=0.05, 0.9, 0.05 

 

The default charge envelope weights (i.e., ChargeEnvelopeWeights=0.07, 0.11, 0.2, 
0.24, 0.2, 0.11, 0.07) will work well for masses with at least 5 or 6 charge states. 

• Improved Monoisotopic Mass Calculation 

Deconvolved isotope series may get slightly distorted by one or more signal interference events 
at specific charge states, especially for larger masses. This might result in monoisotopic mass 
calling errors. Advanced command AdvancedMonoCalculation improves the monoisotopic 
mass calculation by using both the deconvolved mass spectrum and the original MS1 spectrum 
to make the monoisotopic mass calls. Using MS1 spectrum improves the monoisotopic mass 
calls, given that there are many isotope envelopes (corresponding to different charge states) 
from which a reliable statistic can be derived.  

[Intact] 

AdvancedMonoCalculation=true 
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• Remove Singly Charged Peaks allows the user to remove singly charged peaks with m/z 
(maximum 2500). For example, a value of 0.02 directs the software to remove singly charged 
peaks down to 2% of base peak. 

[Intact] 

RemoveChargeOne=0.02 

 
• Monoisotopic Mass Calculation feature allows the users to compute monoisotopic mass using 
an oligonucleotide averagine model for mass peaks up to the set MaxMonoisotope value. This 
command should be used in conjunction with convolution parameters that support isotopic 
resolution (for example, m/z spacing of 0.01 Thomsons and mass spacing 0.1 Da, with similarly 
small smoothing sigmas). However, the software will fit the averagine model whether or not the 
mass peak has isotopic resolution. 

[Intact] 

MaxMonoisotope=30000 

 

• Show Observed Mono shows orange diamonds at the observed monoisotopic mass on the 
Deconvolved Mass Spectrum plot 

[Intact] 

ShowObservedMono=true 

 
• IsotopeSpacing helps the deconvolution whenever peaks are isotope resolved and do not 
appear in 3 or more charge states. 

[Intact] 

IsotopeSpacing=5 

 

• ExtraSmoothingforCentroid can be used to better resolve peaks with overlapping isotopic 
envelopes. The value for ExtraSmoothingforCentroid is false by default.  

[Intact] 

ExtraSmoothingforCentroid=false 

 

• Improvement in performance for large projects  

The advanced command MS2TableMaxNumberSequences=10 adds a time filter to MS2 data 
when there are too many sequences (>10) to load. This command modifies how many 
sequences are displayed in the MS2 data table. A lower value = better performance upon 
opening the project. Note: This applies only when no candidates have been selected 
(immediately after project open)  

[Intact] 

MS2TableMaxNumberSequences=10 

 

• Adjustment of annotation rendering within the MS2 plot 

The advanced commands Alpha and AnnotationStickMinWidth adjust the rendering of the 
annotation bars within the MS2 plot. Alpha represents the transparency of the annotation bars 
on a 0-255 RBY color intensity scale and AnnotationStickMidWidth represents the width of the 
annotation bar.  

[MS2Plot] 

Alpha=50 



Oligo User Guide v5.12                   

 

59 

 

AnnotationStickMinWidth=3 
 

• Fragment ion intensity is now taken into account for MS2 fragment scoring  
As of Byos v5.6, when MSMS fragments are available, the software is now able to use the 
intensities of the fragments to add validity to the scoring. 

The scoring can be evaluated during MS2 annotation process by checking “Score fragments“ 
option in MS2 annotation options and setting a desired score threshold for ion annotations.  

The default score cutoff is 10.  A different score cutoff can be set under the Advanced settings 
during Project Creation, affecting all MS2 scores in the table. 

[MS2] 

FragmentScoreThreshold=10 
 

 

When applied, the scores will be displayed and the cutoff applied during scoring and MS2 
annotation. Users can change this within the MS2 annotation options. 

Intensity plays significant role in scores if otherwise desirable isotope patterns are observed in 
conjunction with low scores due to a lower intensity advanced parameter. The following advanced 
command can be used to turn off intensity consideration: 

[MS2] 

IntegrateSNIntoFragmentScore=false 
 

 

To switch to the original method of fragment isotope scoring, the following advanced parameter 
can be used: 

[MS2] 

FragmentMatchScoringMethod=KL 
 

 

 

 

 

 


